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Description 

This session covers the collaboration between architects and design visualization specialists 
within the Live Design network. Once a Revit software user generates an Autodesk LIVE 
project, any design visualization specialist can take the project to a higher level. Using 
knowledge from 3ds Max software and Stingray game engine, you will learn how to easily add 
dynamic content to create an immersive presentation. This hands-on lab gives an overview of 
the combined power of each software system. During the lab, we will go from Revit software, to 
Autodesk LIVE software, to Stingray game engine, and then we will close the loop by sending 
the project back into Autodesk LIVE. Game engine technologies can really enhance the design 
visualization process—it’s all about real-time storytelling! 
 

Your AU Expert 

Bruno Landry has been a design visualization artist for the past 15 years, specializing in 
consumer products and transportation design. He studied visual arts and completed a bachelor 
degree in Industrial Design at the University of Montreal in 2004. During his student years, he 
discovered a passion for computer graphics.  
 
Complementary to his design background, Bruno has a good graphic eye and a sensibility for 
beautiful things. He draws on his skills and esthetics in his role at Autodesk Inc., where he is a 
talented and passionate designer within the LIVE Design Group. Bruno’s team focuses on 
developing game engine technologies in the design space.  
 

 
 

Learning Objectives 

 Process a Revit project with Autodesk LIVE Service and open it in Stingray 

 Edit Stingray materials and import content  

 Use the Live Link between Stingray and 3ds Max  

 Trigger animation in Stingray using Level Flow 
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LIVE Design  
A solution to explore and communicate your designs 

LIVE Design is the ecosystem of products that will help you to create stunning interactive 
visualizations. Whether you are an architect or a design professional working in Revit, you have 
a vision and have a story to tell. LIVE Design provides you with a solution to easily and effectively 
communicate your ideas to peers and clients. Alternatively, you can be a design visualization 
artist who needs to bring design ideas to life and harness the power of interactive technologies. 
 
The future is LIVE: our goal is to enhance interactive experiences in the virtual word with 
Autodesk LIVE and Stingray. 
 

Collaboration within LIVE Design 
 Architects and Design Visualisation specialists collaborate on the same dataset. 
 
This document explains the workflow to edit an Autodesk LIVE project in Stingray, how you can 
leverage 3ds Max to enhance it even more, and finally how to send all the modifications back to 
LIVE. Here is an overview of the ecosystem: 
 

 
LIVE DESIGN DIAGRAM 
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Villa Martini  
The LIVE Design ecosystem  

Villa Martini was an internal project made by Amer Yassine. A former architect, Amer is now a 
Learning Content Developer in the LIVE Design group. He’s also the 3dsMax Youtube channel 
guru. The Villa Martini dataset was intended to be the Autodesk LIVE Viewer splash screen image 
and also a sample scene available for users. We wanted to show how an architect working with 
Revit and LIVE can team up with a visualization specialist to collaborate on the same dataset. 
 

Enhancing Villa Martini 
The goal of this handout is to provide you with the steps to go from an “out of the box” LIVE 
project, enhance it using Stingray and 3ds Max, and finally to close the loop and send the 
project back to Autodesk LIVE. 

Scope 
The whole process of editing the dataset and creating the LIVE sample scene took a few 
days; since this AU Lab only lasts 1h30, I will give you a complete overview of the 
process rather than covering every single detail of the project.  
 

 
AUTODESK LIVE SPLASH SCREEN - VILLA MARTINI 

 
The sample scenes were made available for users to familiarize themselves with the product. 
However, the assets available are only “published” versions of the projects, meaning users can 
try them out in the LIVE Viewer app but they cannot access the source LVMD project file. Since 
the goal of this class is to show the collaboration workflow between the two apps, the good 
news is that you’ll have access to the full source project! 
  

https://www.youtube.com/channel/UClS3gPxzFYgTUz6JOIruyqA
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Prerequisites  
Software version compatibility 

Autodesk LIVE 1.0 and LIVE 1.1 are both built on Stingray 1.2.5. Therefore, if you want to do the 
"round trip" between LIVE and Stingray, you must absolutely use Stingray 1.2.5. We know the 
currently available Stingray version is 1.5, but unfortunately this is a current limitation. 
 
The product team is working very hard so that the 2 products are synchronized, be patient it will 
happen! 
 
Before we start the actual work, please make sure that you have the following software 
installed: 

 Revit (2016 or 2017) 

 Autodesk LIVE (1.0 or 1.1) 

 Stingray 1.2.5 

 3ds Max (2016 or 2017) 

 StingrayDCCLink2016 (located in \Program Files\Autodesk\Stingray\1.2.564.5\extras) 
 
Available datasets: 

 LIVE 
            - Villa_Martini_1.0.lvmd 
 - Villa_Martini_1.1.lvmd 

- Villa_Martini_Improved (sample scene version) 
 

 Stingray projects (various states, .zip format) 
            - Villa_Martini 
 - Villa_Martini_cooking (ready for light baking) 
 - Villa_Martini_baked (after light baking) 
 - Villa Martini final (sample scene – final state) 

 FBX Assets 
            - bird_fly_01.fbx 
 - clock_01.fbx 
 - dixon_lamp.fbx 
 - SM_Chair.fbx 
 - SM_Table_Exterior.fbx 
 

 Texture Assets 
 - Concrete 
 - Wood Wall 
 - Metal Wall 
 - Stucco 
 
DOWNLOAD HERE! 
 
 
 
  

http://www.autodesk.ca/en/products/revit-family/overview
http://www.autodesk.com/products/live/overview
https://knowledge.autodesk.com/support/stingray/downloads
http://www.autodesk.ca/en/products/3ds-max/overview
http://help.autodesk.com/view/Stingray/ENU/?guid=__stingray_help_importing_assets_link_to_dcc_html
https://autodesk.box.com/s/2ba20htefb291es93dm3qclylqqqq835
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Workflow  
1- Revit to LIVE  

 In Revit, open your Revit model and then select Add Ins > Go LIVE.  
 

 
 
Take note of the output destination, it’s important for the next step. 
 

  
 

 When the cloud service processing completes, open the project in LIVE to see how it looks 
straight out of the box, no manual work involved. 

 
Important: When a project is loading in LIVE, it's actually being extracted/unzipped in 
mydocuments/Autodesk LIVE/data; each project has a unique 7 digit ID.   
 
The project is now loaded in LIVE; let's have a look at the project and start to figure out what we 
can improve. It already looks okay, but let's make it even better. 
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2- LIVE to Stingray 
Opening a LVMD file in Stingray 
 
Important: LVMD file are in fact disguised zip files.  
 

 To extract the data, you can either rename the file extension from .lvmd to .zip and then 
extract/unzip the archive, or use 7zip which recognizes .lvmd as an archive file. 
 

 
 

 Once it's extracted, rename the project folder name; avoid any special characters, especially 
the "." as it can cause problems later in the process. 

 
Let's start Stingray! 

 If you have multiple versions of Stingray installed, start the Game launcher (now called the 
Stingray launcher) and select version 1.2.5. 

 
 

 You should now have the Project Manager windows in front of you. Select Add Existing and 
then browse to and select the folder you extracted. The project needs to compile; this can 
take several minutes. 

 

http://www.7-zip.org/
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During the compilation process, you may encounter a bug that opens a grey and empty UI. This 
usually happens when you switch from one version to another. The trick to fix it is just to reset the 
layout (in the Windows menu). 
 

        
 
 
 

 When the compilation process is complete, you'll seemingly have an empty project. You just 
need to open a level; select File > Open Level and then select our Villa Martini level. 

 

 
 

When a level loads, you usually start at the 0-0-0 location. In our case today, this locates us 
under the pool, but don't worry. 
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Navigation 
 
The first time you launch Stingray, you may be faced with a transparent blue mesh covering 
your model, this is the Navmesh. Let’s turn it off for now, we’ll come back to this later. 
 

 Go to Window > Navigation. Under Generate, clear the Render NavMesh check box. 
 

    
 
LIVE project structure overview 

 

A LIVE project structure can look similar to a standard Stingray project but there are a few 
differences. Inside the Stingray project root, in the /data folder, you’ll find the unique 7 digit ID 
folder containing the LIVE project. The common folder contains everything shipped with every 
LIVE project (background, RPC trees, RPC characters and materials). The content folder 
contains all the data from Revit (materials, textures and the geometry). 
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3- Stingray 
Editing a LIVE project in Stingray 
 
Editing an existing material 

 Navigate to and select the dining room door frame. The material applied to this unit is shown 
in the Property Editor panel, click on Goto resource to locate this material. 

 

Autodesk LIVE generates custom Stingray shaders that try to mimic the Revit material. 

 Change the Generic Color value to change the windows and door frame material to black. 

 

Editing a unit (geometry) in 3ds Max 

Using the Live Link between 3ds Max and Stingray, you can easily establish a connection 
between the two applications and send data back and forth. 

 Once the Stingray DCC link is installed and properly configured, in 3ds Max's Stingray 
menu, select Connect. 

 

http://help.autodesk.com/view/Stingray/ENU/?guid=__stingray_help_importing_assets_link_to_dcc_install_dcc_html
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We have now established a connection.  

 Select this main wall, right-click and then locate the unit in the asset browser. In the asset 
browser, right-click on the unit and select Send to 3ds Max. 

 

The unit is now loaded in 3ds Max. Let’s apply a new material and create a new material ID (this 
cannot be done in Stingray). 

 

 Use the material picker to see what material is applied to the mesh. 

The wall has 3 material IDs and 3 materials applied. Let's create a new ID (4) and a new material 
called black_metal for a part of the exterior wall, as shown in the image. 

 



 

 

Page 11 

 When done, in 3ds Max’s Stingray menu, select Update. This updates the unit directly in 
Stingray. 3ds Max asks if you want to overwrite the .fbx file, click Yes to push the changes to 
Stingray. 

 

 We can see the unit is updated, there’s a new black material applied to a section of the exterior 
walls. However for some reason, the orientation of the updated unit is wrong; a 180° rotation 
on the Z axis will fix this. 
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4- Adding new content 
Texture asset 
 
Typically, when working in 3ds Max, linked assets are textures, xref cad drawings or Vray mesh 
proxies. Either you manually create folders to manage your assets or you use the 3ds Max project 
structure by defining the project folder.  When you work in Stingray, any assets you import in your 
project are actually copied in you project structure. 

Earlier we discussed the structure generated by default in a LIVE project, we'll respect this 
structure and add new content in it. 

Let’s say we want to change the texture of a material, we'll import a new texture in the asset 
browser. There's already a texture folder, so let's import new textures in the same folder. 

 

 
 

 You’ve been provided with a new wood texture (normal, diffuse and AO), import the 3 of them. 

 

 Select the material to edit (Brazilian teak) and change the parent material (the base shader), 
we will use the standard base. Under Parent Material, click the folder icon next to the name. 
In the Content Browser, search for the standard base and select it. 
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We are not really creating a new material, we are just changing the base shader of this material. 
For example, in 3ds Max a Blend, Composite, or Multi/Sub-Object are various base shader. The 
concept here is similar. 

 From the Asset Browser, go in the Textures sub-folder and then drag and drop the diffuse, 
normal and AO maps in their respective slots. You can also adjust the roughness value, but 
make sure you have checked the Use Diffuse, Normal and AO Map checkbox. When done, 
save the material and you'll see the result immediately in the viewport. 

 

 Let's do the exact same process for the concrete material: 
a. Import the new Stucco textures. 
b. Change the parent material to a standard base. 
c. Apply the new textures to the material. 
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5- Removing assets 
Models / geometry 

The furniture in the dining room are from a Revit family. They lack details, so let's change them.  

 Select the table and all the chairs but one, and delete them in the viewport (let's keep one 
chair for a quick example). 

 
 

 The furniture aren't in the viewport anymore but they remain in our project. The viewport is a 
graphic representation of the Level. Even if the unit isn't used in the viewport, if we want to 
completely remove it from our project, we need to delete it from the Asset Browser. In the 
folder structure, locate the two units (in /data/projectID/content/units), right-click and select 
Delete. Do the same for the table. 
 

 
 

 By deleting the assets from the Asset Browser, you completely remove the asset from the 
project. Now we still have one chair in the viewport, let's reset the engine to see what will 
happen (Edit > Engine > Restart Engine or Ctrl+F6). The pink "?" indicates there is a reference 
to a missing resource because the chair unit was deleted. Select the "?" and delete it. 
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6- Adding new content 
Models / Geometry 
 
Let start adding new assets in the scene. I have a few models in .fbx format we can use in the 
dining room. 

Important: I strongly recommend you create one folder per asset in the Asset Browser. It will be 
easier to manage the project; for example, if you try a few different chairs, it's a lot simpler to 
delete the unit and materials by deleting the entire folder. Usually new users import everything in 
the project root and it gets messy quite fast; we want to keep our project clean. 

I usually create an Import folder inside the Content folder, with a sub-folder for every asset or 
group of assets. 

 

 

 Create a folder for the kitchen table, select Import and then select the SM_Table_Exterior.fbx. 

 In the Import windows, import the materials and textures but make sure you don't check 
Animation and Skeleton.  Since this table isn't animated, we don't want to create a skeleton 
structure for this table. 
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 The table is now imported with its material. Drag and drop the table in the viewport; place it in 
the dining room. 

 

When you prepare an asset in 3ds Max like this table, make sure the table is set at 0-0-0 because 
Stingray will retain the Max’s 0-0-0 world coordinates and use it as the pivot point. Also, it's a 
good idea to do some house-keeping: name your objects and name the materials, all that data is 
carried over in Stingray. 

 

 Using the same process, let's import the dining chair. Again, let's create a new folder and 
import SM_Chair.fbx. 
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 When the chair is imported, drag it in the viewport. You can use the Shift+drag method to 
create instances of the chair around the table. 
 

 
 

We can now spend some time editing the material’s properties; note that my materials are named 
badly and it’s difficult to see which material is the metal or the plastic. 

 
 

7- Adding new content 
Animated assets 
 

Now that we know how to import static assets, let's import an animated asset. 

 Just like we did before, create a folder named Bird and import the bird_fly_01.fbx. This time 
in the FBX Import window, check Animation & Skeleton. 
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You’ll notice that we have a Skeleton and an Animation folder. The bird animation was made in 
3ds Max, it's a 300 frame-long sequence. 

 

 Drag and drop the bird asset in the Level viewport close to a tree, like in the following image. 

 

What we want to do now is to trigger birds flying away from the tree, we'll cover this in the next 
section. 

 

8- Triggering animation using Level Flow 
Level Flow 
 
Flow is a node based visual programming system, similar to the Slate Material Editor in 3ds Max 
or the Shader Graph Editor in Stingray. Typically in Flow there is an Event that triggers an Action 
on a specific Unit. What we would like to accomplish in our case is when the level is loaded, we 
want to play an animation on our bird unit. 

 Select the bird in the viewport. Since it's hidden in the tree foliage, select the tree and press 
H to hide the tree. Select the bird and in the Level Flow tab, right-click and select Create Level 
Unit bird_fly. 

 

 Create a new event node called Level Loaded. Right-click, select Event and then select Level 
Loaded.  To find a specific Flow node you can also press Tab and search for the Flow node 
name. 

 



 

 

Page 19 

 Let’s add an Animation node. Press Tab, search Animation and select the node Animation 
Clip Reset and Play.  Connect the Unit node to the Animation node and select the animation 
you want to play on the bird unit. Click on the animation input and select bird_fly_01, it's the 
only animation in the project right now. 

  

 

 Now we just need to trigger the animation play. Connect the Level Loaded node output to 
the Animation play input. 

 

 If we test the level right now (hit the Play button or F8), we'll see that when the level is 
loaded, our bird is flying away, which is alright, but let's edit a few more settings. Increase 
the Speed to 2 and set the Loop option to false. 
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 To make this more interesting, let's duplicate the bird in the Level Viewport to create few 
instances.  When done, apply the animation to the new birds as well.   

 

 

 Go back in Level Flow, select the Unit and the Animation node and create 2 copies (using 
Ctrl+C and Ctrl+V). When you duplicate a Level Unit node, you'll get a red highlight around 
the node because you cannot have the same Level Unit twice in Level Flow. 

 

 Change the input in the Level Unit note so that each bird in the Viewport has its own Level 
Unit node. 

 Also, let’s edit the speed for each Animation node, just do a small variation so that the bird 
won't be flying exactly at the same speed. 
 

 

 

Important: Since our goal today is to edit a LIVE project in Stingray and send it back to LIVE, 
there's a current limitation to trigger events of which you need to be aware. Keyboard input or 
character trigger are currently not supported for this workflow. The only way to trigger an event is 
to use the Level Loaded. 
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Let’s make the birds fly away when the Level is loaded but also loop the bird animation with a 
specific timing. To do so, we'll use a Delay node to trigger the animation every 45 sec. 
 

 Make sure the Level Loaded output is connected to the 3 animation Play inputs so each time 
the level starts, the birds fly away. 

 

 Add a Flow node called Delay (hit tab, search for Delay). Connect the Level Loaded to the 
Delay node (this will activate the Delay), set the time to 45 seconds and connect the output of 
the Delay node to each Animation node’s Play input. 
 

 
 

 Now when the Level is Loaded, the bird_fly animation will play on each of the birds in the level 
and it will play again every 45 seconds. 

 

9- Using assets from the common folders 

Models used to replace the Revit RPC are shipped with every LVMD project, for example the 
whole trees & shrubs library is available in \common\units\vegetation. At any point you can edit, 
move and replace any RPC trees in Stingray. From the Asset Browser, just drag and drop any 
models in the Level Viewport and use the move/rotate/scale tool to edit them. 
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10- Sending the project back to LIVE 

 To send back the project from Stingray to LIVE, first of all save all changes made in Stingray 
and then locate the project in Windows Explorer. Right-click on the project root and select 
« Show in Explorer ». 
 

 
 

 There are two ways to get your project back in LIVE: 

 Do the following: 
a. Recreate a new LVMD file by creating a new .zip file and renaming it .LVMD. 

This LVMD can be loaded in LIVE. 
b. Select all the project root’s contents and create an archive.  
c. Rename the .zip archive to .LVMD. 

 

      
 
Important: When creating the archive, make sure the files are at the top level, not in a sub-
folder. 

Alternative method (better!) 
 

 Copy the LIVE project folder (project with an unique 7 digit ID) directly in 
\Documents\Autodesk LIVE\data. 
 

 
 
If the project was previously opened in LIVE before any edits were made in Stingray, you’ll need 
replace/overwrite all the files to get the new version of the project. Stingray can remain open 
during this process, you just need to save all the changes before copying the project and restart 
LIVE when it’s done. 
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Important: You can't have both the original and the edited version of the project in LIVE, since 
they share the same project ID name. If you want to have both, you can reprocess the project on 
the cloud and generate a new LVMD. 
 
Useful tip: Edit the Villa_Martini_2017.metadata file located in the LIVE project root to change 
the name of the project in LIVE. 
 

11- Editing physics 

During the LIVE cloud process, the service reads the BIM info from Revit and recognize all the 
doors; all standard Revit family doors are automatically animated in LIVE. 
 

 This is a very interesting feature, but maybe you would like to restrict the user from 
entering a particular room. It’s possible but you’ll need to edit the door to achieve this. 

Locate a door you want to lock, right-click on it and select Open Selected in Unit Editor. 
 

 
 

 We need to modify the physics applied to the doors. The physics are responsible for all 
the collisions with the characters; for example, I cannot walk through walls because 
physics are applied to the walls.  Once the door is loaded in the unit editor, select the two 
physics actors on the left. In the Properties panel, go down and change the Shape 
Template from Doors to Default. 

 
Note that this modifies all instances of the same door in the project. If you want to lock only a 
single door, you'll need to create a copy of this door to make a new unit. 
 
Editing the physics will prevent the character to walk through the door, we also need to edit the 
BIM info to stop the door animation.  Select the door you want to “lock”, in the Property Editor, 
change the Category Name from Door to Locked for instance.  You must do this for each door on 
which you want to remove this animation. 
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12- Navigation mesh 
 
The navigation mesh is used for character navigation in the scene. For example, in LIVE when 
you are in Tap & Go navigation mode, if you click on the second floor the NavMesh is used to 
calculate the shortest path to your destination. Since we have modified the furniture layout, we 
need to regenerate the NavMesh. 
 
In the following example, I’ve modified the configuration of the red sofa. 
 

 
 

 From the Window menu, select Navigation to open the Navigation window. Under Generate, 
check the Render NavMesh option, you'll see a transparent blue mesh. That's the NavMesh. 
Simply click on Generate to update the Navigation Mesh. 

 

 
 
One problem we might want to fix is that currently we can see that the NavMesh is covering the 
pool, which means you can actually walk on water! To fix this, we need to remove this unit from 
the NavMesh calculation. 
 

 Select the unit in the viewport (ex: the water plane), right-click and select Find Selected in 
Asset Browser. 

 In the Asset Browser, right-click the unit and select Show in Explorer. This opens a Windows 
Explorer window. 

 Open the highlighted .unit in a notepad editor (I recommend Notepad++). 
 

 
 

 Add this line of code gwnavgenexcluded = true under data = {, this exposes the NavMesh 
exclude function. 

https://notepad-plus-plus.org/
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 Re-generate the NavMesh in the Navigation panel and you'll see the water surface is no longer 
included in the NavMesh. 

 

 
 

 Do the same thing for the bottom of the pool, this way we’ll make sure the character cannot 
click the bottom of the pool and get stuck under water. Once it’s done just regenerate the 
NavMesh once again. 

 

 Another setting you may also want to edit is the Entity Radius. This is the size of our character.  
Changing the radius to 0.1 instead of 0.4 will close the missing gap around the pool. 
 

        
 

 When you’re happy with the result, you can uncheck the Render NavMesh to hide it. 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Page 26 

13- Performance 

You must be careful when you are modifying the project settings and especially adding content 
in your scene, because this can drastically affect the performance. A quick tip to get information 
about your project performances is to use the Artist Performance Hud tool. 
 

 To activate the Performance Hud, in the Level Viewport’s top left corner, click View > 
Performance Hud > Artist Performance. 

 

 
 
In this case, we can see the Global Lighting could be optimized. I know that we have currently 
more than 100 dynamic lights, we'll see in the next topic how to fix that. 
 
 
 

14- Light baking 

Light baking is probably one of the top reason users want to take advantage of the collaboration 
workflow between LIVE and Stingray. The light baking process consists of baking the light 
information in a texture, so the lights in the scene won't need to be dynamic anymore; they won't 
be rendered at each frame. It has a huge impact on the performance and on the visual quality, it 
will create a global illumination look in the scene. 
 
We need to make sure that all our units in the scene have a secondary set of UV map to store 
the light map data. All the geometry generated from the LIVE cloud service already have that 
secondary map.  The objects we imported via FBX in Stingray will need the secondary set of UV. 
 
Note that unfortunately this feature was removed from LIVE 1.1 due to the major increase 
in compiling time. 
 
You can manually create the secondary UV map in 3ds Max using a basic flat unwrap and setting 
the map on channel 2, or by using a 3rd party tool such as SteamRoller. 
 
 
 
 
 
 

http://www.scriptspot.com/3ds-max/scripts/steamroller
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 The missing UV can also be generated in Stingray using the Unit Editor. Select one of the 
units we imported previously (for instance the dining chair). Open the unit in the Unit Editor, 
select all the meshes and under Settings in the Properties panel, check the Generate UV-
Unwrap option. Save and close the unit, you'll notice that Stingray is generating the missing 
UV map and re-compiling the unit. 

 

 
 

 Repeat the same process for all the units you imported in Stingray. 
 
Important: Complex objects take more time to compile. 
 
Useful tip: Since Stingray is data driven, you can easily batch edit multiple units using a text 
editor. Simply change the following line in each .unit file: 
light_baking = "none" to  generate_uv_unwrap = true 
 
 
 
Some important things about light baking: 

 Since our goal is to go back in LIVE, we cannot bake the sunlight; LIVE has its own 
shading environment and dynamic sun system. 

 Bake when the layout is final. If you move furniture after the baking is complete, you’ll get 
unwanted shadow. 

 Avoid any period “.” in the folder file structure, this causes the baking solution to be saved 
outside of the project and cannot be loaded correctly. 
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We are now ready to bake! 
 

 Select all the lights in the Scene Explorer (except the sunlight) and check the Cast 
Shadows option in the Property Editor - this option is turned off by LIVE for better 
performance. Remember the Performance Hud feature? Look at the impact of turning on 
the Cast Shadows option on 106 dynamic lights. 

 

     
 
The next step is to actually tell Stingray which lights we want to bake. As I’ve mentioned, we 
cannot bake the Sunlight, but you can decide to keep some dynamic lights if there’s an animated 
object affecting nearby shadows. 
 

 Select all the lights except the Sun. 

 Under Beast, check the Baked option. 
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 In the Window menu, go to Lighting and select Bake Lightmaps. 
 

                          
 

You can choose from two different bakers: Beast or Stingray (beta). The Stingray baker is 
made internally by the Stingray team and the results are way better in my opinion, so we’ll 
use this one.  
 
The settings are quite simple: the Lightmap Texel Scale is the definition of the lightmap, higher 
values give better results but will take more time to compute. The Total Sample Passes is 
basically the number of time the baker iterates, giving you better results with each pass. When 
the baking is running you can navigate in your scene to see the progress, you can also cancel 
or save the result at any time. The process stops when it reaches the number of passes 
specified. 

 

 For a first test, a value of 10 for the texel scale and 50 for the number of passes will be 
enough. For the final baking solution, you can go up to 100 for the texel scale and 512+ 
for the number of passes. Note that the Stingray baker is GPU based and it also requires 
a good amount of RAM, especially at the end of the process during the saving step. 
Depending on your workstation configuration, you may run into memory issues if the 
settings are too high. 
 

 

 

 Before the final bake, do a last check on the scene. I’m deleting the RPC character from 
my viewport but I’ll keep them in my scene just in case. 
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Once the scene is baked and the baking solution is saved, there’s 2 important things to notice 
besides the overall visual quality improvements: 
 

 The size of the project is now 10 times bigger; we have generated more than 600+ .dds 
texture for the lighting solution. The textures are located in the Villa_Martini_2017-
lightmaps folder, in the LIVE project root next to the .level file.  

 
 

 The performance is much improved; using the Performance Hud we can see the Shadow 
Casters and the Global Lighting performances quite are acceptable. 

 

At this point, it is a good idea to send the whole project back in LIVE again to check the result.   

 Use the same method explained before: save all changes, locate the LIVE project root (unique 
7 digits ID folder) and copy it directly in \Documents\Autodesk LIVE\data. Relaunch LIVE and 
you should see all the modifications. This time it will probably take longer to load in LIVE since 
all the light baking information needs to compile.  
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15- Editing the Shading Environment 

One last thing we should spend time tweaking is the Shading Environment; a series of post-effects 
that can enhance the look of the scene.  
 

 In the Entities section of the Scene Explorer, select the midday_shading_enviroment to 
access the various components in the Property Editor. 

 
I won’t go in details on each of the post effects, these can be adjusted to get the desired aesthetic 
for the project. I usually spend time tweaking the Screen-Space Ambient Occlusion, the Bloom, 
the Vignette & the Depth of Field. Just keep in mind that these post effects will affect the 
performance; use them wisely! Just like we did previously, you can use the Performance Hud to 
see the impact of each of these components. 
 

    
 

 Let’s do a final update to LIVE using the same method we have used before and here’s 
the result: 

 

 
 

Once you master these tools, you’ll be able to edit and enhance any LIVE project. I hope you 
have found this class helpful and that you’ll start applying this workflow on a daily basis. 

Thanks! 

- Bruno Landry 


